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Welcome to Krita
When you start Krita for the first time there will be no canvas or new document open by default. You will be 
greeted by a welcome screen, which will have option to create a new file or open existing document, see 
previously opened files, and find more resources prepared by the Krita Community.
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A new document can be created several ways:

1.	 Click on File from the application menu at the 
top.Then click on New.

2.	 Press the New Image icon on the left side of the 
home menu

3.	 Use the shortcut Ctrl + N 

A new box will pop up where you can change the file 
settings before opening a blank canvas.

Creating a New 
Document

Opening Files
Similarly, an existing file can be opened several ways:

1.	 Click on File from the application menu at the 
top. Then Click on Open

2.	 Click on the Open Image folder icon under the 
New Image icon

3.	 Click on the image or hyperlink under Recent 
Images in the center of the home screen

2
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Saving and Exporting
Now, once you have figured out how to draw 
something in Krita, you may want to save it. The save 
option is in the same place as it is in all other computer 
programs: the top-menu of File, and then Save. Select 
the folder you want to have your drawing, and select 
the file format you want to use (.kra is Krita’s default 
format, and will save everything). And then hit Save. 
Some older versions of Krita have a bug and require 
you to manually type the extension.

If you want to show off your image on the internet, 
check out the Saving For The Web tutorial.

These options are great for people doing production work, who need to switch 
between files quickly or have backup files in case they do something extreme. 
Krita also has a file backup system in the form of auto-saves, backup files and crash 
recovery. You can configure the option for these features in the general settings.

1
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1.	 Save (Ctrl + S):

2.	 Save as (Ctrl + Shift + S): 

3.	 Open existing document as untitled document: Similar to 
Open…, however, Save will request you to specify a saving 
location: you’re making a new copy. This is similar to Import… in 
other programs.

4.	 Export (Ctrl + E): 

5.	 Save incremental version: Allows you to quickly make a snapshot 
of the current image by making a new file with a version number 
added to it.

6.	 Create copy from current image: Similar to Open existing 
Document as Untitled Document… but with the currently 
selected image.

https://docs.krita.org/en/tutorials/saving-for-the-web.html#saving-for-the-web
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Document Set Up

When opening a 
new image, the New 
Document dialog box 
will open where you can 
customize the project 
file’s settings. Here are 
some common settings to 
customize the document: 

1.	 Set the width 		
and height

2.	 Quickly set the 
canvas horizontally 
or vertically

3.	 Set the resolution. 
Larger resolutions 
will create a file 
that takes more 
space but will hold 
more detail.

4.	 Change the units 
that the file will 
use. This will affect 
the rulers and other 
measurements in 
the document
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5.	 Make sure that the 
color profile is RGB

6.	 Make sure that the 
depth is set to 8-bit 
integer/channel in 
the color section. 
For advanced 
information about 
the color and color 
management refer 
to Colors.

7.	 Press Enter or 
the Create button 
to open a new 
custom document
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Interface Tour
Krita’s interface is very flexible and provides an ample choice for the artist to 
arrange the elements of the workspace. An artist can snap and arrange the 
elements, much like snapping together Lego blocks. Krita provides a set of 
construction kit parts in the form of Dockers and Toolbars. Every set of elements 
can be shown, hidden, moved and rearranged, that lets the artist to easily customize 
their own user interface experience.

The Krita interface is 
very malleable and 
customizable. Let’s look 
at the default settings:

1.	 Traditional File or 
action menu found 
in most windowed 
applications.

2.	 Toolbar – This is 
where you can 
choose your 
brushes, set 
parameters such as 
opacity and size and 
other settings.

1
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3.	 Sidebars for the 
Movable Panels/
Dockers -- In some 
applications, these 
are known as 
Dockable areas. 
Krita also allows 
you to dock panels 
at the top and/or 
bottom as well.

4.	 Status Bar – This 
space shows the 
preferred mode for 
showing selection 
i.e. marching ants 
or mask mode, 
your selected 
brush preset, Color 
Space, image size 
and provides a 
convenient zoom 
control.

5.	 Canvas -- The 
canvas sits in the 
middle and unlike 
traditional paper, 
or even most 
digital painting 
applications, 
Krita provides 
the artist with a 
scrolling canvas 
of infinite size.
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Dockers
Krita subdivides many of its options into functional panels called 
Dockers (also known as Docks). Dockers are little subwindows in 
Krita’s interface that can be 
“popped” in and out of their docks 
at any time to see a greater range 
of options. They contain useful 
tools, like the color selector, layer 
stack, tool options, Color Palette or 
list of Brush Presets. 

Think of them as the painter’s 
palette, or his water, or his brush 
kit. They can be activated by 
choosing the Settings menu > 
Dockers sub-menu (see image to 
the right). There you will find a long 
list of available options.

Below are examples of some dockers in Krita.

Using Dockers
Dockers can be removed by clicking the x in the 
upper-right of the docker-window.

Dockers, as the name implies, can be docked into 
the main interface. You can do this by dragging the 
docker to the sides of the canvas (or top or bottom 
if you prefer).

Dockers can be prevented from docking by pressing 
the Ctrl key before starting to drag the docker.

You can arrange the dockers in almost any permutation and combination according 
to the needs of your workflow, and then save these arrangements as Workspaces.

6
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Workspace Chooser
The button on the very right of the Toolbar is the workspace chooser. This allows 
you to load and save common configurations of the user interface in Krita. There 
are a few common workspaces that are arreanged to highlight specific features 
such as animation.

Workspaces Chooser and Customization

Workspace Customization
In addition to rearranging the dockers according 
to your preferences, Krita provides and saves your 
configurations as Workspaces. 

First, arrange the dockers to you preference. 

Next, open the workspaces drop down. You can save 
your configuration as a workspace or as a window layout. 
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Krita uses these to control values like brush size, opacity, flow, Hue, Saturation, etc. 
To the left is an example of sliders in Krita.

The total range is represented from left to right and blue bar gives an indication of 
where in the possible range the current value is. Clicking anywhere, left or right, of 
that slider will change the current number to something lower (to the left) or higher 
(to the right).

To input a specific number, hold  left or right click on the slider. A number can now 
be entered directly for even greater precision.

Pressing the Shift key while dragging the slider changes the values at a smaller 
increment, and pressing the Ctrl key while dragging the slider changes the value in 
whole numbers or multiples of 5.

Changed in version 5.1: Shift while dragging will now also enable “relative mode”, 
which means that the cursor can be dragged outside the slider area.

Sliders

Toolbars are where some important actions and menus are placed so 
that they are readily and quickly available for the artist while painting.

You can learn more about the Krita Toolbars and how to configure 
them in over in the Toolbars section of the manual. Putting these to 
effective use can really speed up the Artist’s workflow, especially for 
users of Tablet-Monitors and Tablet-PCs.

Added in version 5.0: In addition to shortcuts and the toolbar, you can 
also search and quickly through all actions via the action search bar, 
which is accessed with Ctrl + Enter.

Toolbars
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The Pop-up Palette is a feature unique to Krita, 
designed to increase the productivity of the artist. 
It is a circular menu for quickly choosing brushes, 
foreground and background colors, recent colors 
while painting. 

To access the palette, select the brush tool and right 
click on the canvas. The palette will spawn at the 
position of the brush tip or cursor.

By tagging your brush presets you can add particular 
sets of brushes to this palette. For example, if you add 
some inking brush presets to inking tag you can change 
the tags to inking in the pop-up palette, and you’ll get 
all the inking brushes in the palette.

You can tag brush presets via the Preset Docker, check 
out the resource overview page to know more about 
tagging in general.

If you call up the pop-up palette again, you can click 
the tag icon, and select the tag. In fact, you can 
make multiple tags and switch between them. When 
you need more than ten presets, go into Settings > 
Configure Krita… > General > Miscellaneous > Number 
of Palette Presets and change the number of presets 
from 10 to something you feel comfortable.

Pop-Up Palette

https://docs.krita.org/en/reference_manual/resource_management.html#resource-management
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Navigating the Canvas
When you create a new document in Krita for the first time you will see a rectangular white area. This is called a 
canvas. You can see it in the image below. The area marked by a red rectangle is a canvas.

When you save the painting as JPG, PNG et cetera or take a print out of the painting, only the content inside this 
area is taken into consideration. Anything beyond it is ignored. Krita does store information beyond this area, you 
just won’t be able to see it. This data is stored in the Layers. 

Many of the canvas navigation actions, like rotation, mirroring and zooming have default keys attached to them. 
You can also find these under View > Zoom, Rotate, and Mirror.

Panning
This can be done through either the scroll wheel, or 
by holding Space +  left click and the directional keys.

Zooming
Discrete zooming can be done through + and 
- keys. Using the Ctrl + Space or Ctrl +  scroll 
wheel shortcuts allows for direct zooming 
with the stylus

Mirroring 
You can mirror the view can be quickly 
done via M key. Mirroring is a great 
technique that seasoned digital artists use 
to quickly review the composition of their 
work to ensure that it “reads” well, even 
when flipped horizontally.

Rotating
You can rotate the canvas without 
transforming. It can be done with the Ctrl 
+ [ shortcut or 4 key and the other way 
with Ctrl + ] shortcut or 6 key. Quick mouse 
based rotation is done with the Shift + Space 
and Shift +  scroll wheel shortcuts. To reset 
rotation use the 5 key.
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Images, Views and Windows
Image
An image is an individual copy of the image that you can open or create via the 
file dialog. The image contains data regarding layers, color space of image and 
layers, canvas size and metadata such as creator, date created and DPI et cetera. 
Because the image is a working copy of the image on the hard drive, you can save 
many versions of different elements in the image. 

Window
If you’ve used a computer before, you know what 
windows are: They are big containers for your 
computer programs.

Krita allows you to have multiple windows via 
Window > New Window. You can then drag this to 
another monitor for multi-monitor use and switch 
between them via the Window menu.

View
A view is a window onto your image. Krita allows you 
to have multiple views, and you can manipulate the 
view to zoom, rotate and mirror and modify the color 
of the way you see an image without editing the image 
itself. This is very useful for artists, as changing the way they view the image is a common way to diagnose 
some common mistakes, like a drawing which is skewed towards one side. Mirroring with the M key makes 
such skewing easy to identify.

If you have trouble drawing certain curves you will enjoy using rotation for drawing, and of course, there is 
zooming in and out for precision and rough work.

Multiple views are possible in Krita via Window > New view > image name. You can switch between them via 
the Window menu, or the Ctrl + Tab shortcut, or keep them in the same area when subwindow mode is active 
in the settings, via Window > Tile.
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Tools

Guide Tools
These are tools like grids and assistants.

Select Shapes Text

Edit Shapes Caligraphy

Freehand Brush Line

Rectangle Elipse

Polygon Polyline

Bezier Curve Freehand Path

Dynamic Brush Multibrush

Transform Move a Layer

Crop

Gradient

Colorize Mask

Fill Bucket

Assistant

Reference Images

Rectangular Slection

Polygonal Selection

Contiguous Selection

Bezier Curve Selection

Zoom

Sample Color

Smart Patch

Enclose and Fill

Similar Color Selection

Magnetic Curve Selection

Pan

Measure

Eliptical Selection

Freehand Selection

Tools help you manipulate the image data. The most common one is of 
course, the freehand brush, which is the default when you open Krita. 
There are roughly five types of tools in Krita:

Paint Tools
These are tools for painting on paint layers. They describe shapes, 
like rectangles, circles and straight lines, but also freehand paths. 
These shapes then get used by the Brush engines to make shapes and 
drawing effects.

Vector Tools
This is the upper row of tools, which are used to edit vectors. 
Interestingly enough, all paint tools except the freehand brush allow 
you to draw shapes on the vector layers. The resulting object won’t use 
the brush preset for outline unlike the ones made with paint tools on 
normal layer.

Selection Tools
Selections allow you to edit a very specific area of the layer you are 
working on without affecting the others. The selection tools allow 
you to draw or modify the current selection. This is like using masking-
fluids in traditional painting method, but whereas using masking fluids 
and film is often messy and delicate, selections are far easier to use.

Transform Tools
These are tools that allow you to transform your layer 
or object on the canvas
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Brushes
Now, on the blank white canvas, just left click with 
your mouse or draw with the pen on a graphic tablet. 
If everything’s correct, you should be able to draw 
on the canvas! The brush tool should be selected by 
default when you start Krita, but if for some reason it 
is not, you can click on the brush icon from the toolbox 
or use the shortcut (B).

Change brushes in the Brush Presets docker (or on 
top, press the F6 key to find this one) with all these 
cute squares with pens and crayons.

If you want to tweak the presets, check the Brush 
Editor in the toolbar. You can also access the Brush 
Editor with the F5 key.

Tick any of the squares to choose a brush, and then 
draw on the canvas. To change color, click the triangle 
in the Advanced Color Selector docker.

Brush engines, as mentioned before, take a path and 
tablet information and add effects to it, making a stroke.

Krita has a LOT of different brushes, all with different 
effects. There are a lot of cool effects inside Krita’s 
brush engines, so try them all out.

Erasing (E)
There are brush presets for erasing, but it is often 
faster to use the eraser toggle. By toggling the E key, 
your current brush switches between erasing and 
painting. This erasing method works with most of the 
tools. You can erase using the line tool, rectangle tool, 
and even the gradient tool.
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Like a landscape painter will first paint the sky and then 
the furthest away elements before slowly working his 
way to the foreground elements, computers will do 
the same with all the things you tell them to draw. So, 
if you tell them to draw a circle after a square on the 
same spot, the circle will always be drawn later. This is 
called the Drawing Order.

The layer stack is a way 
for you to separate 
elements of a drawing 
and manipulate the 
drawing order by showing 
you which layers are 
drawn when and allowing 
you to change the order 
they are drawn in and also 
apply all sorts of other 
effects. This is called 
Compositing.

This allows you to have line 
art above the colors, or 
trees before the mountains, 
and edit each without 
affecting the other.

A new layer is created 
by pressing Insert or by 
clicking the plus button 
at the bottom of the 
layers docker.

Layers and Compositing Raster and Vector Layers
Even though Krita is regarded primarily a raster based 
application, it has some vector editing capabilities as 
well. If you are new to digital painting medium, it is 
necessary that you first get yourself acquainted with 
the concepts of raster and Vector based images.

In digital imaging, a pixel is the lowest element of an 
Image. It is basically a grid of points each displaying 
specific color. Raster editing is manipulating and 
editing these pixels. For example when you take a 
1-pixel brush which is colored black and painting on 
the white canvas in Krita you are actually changing 

the color of the pixel beneath 
your brush from white to black. 
When you zoom in and see a 
brush stroke you can notice many 
small squares with colors, these 
are pixels.

In contrast to raster images, 
vector graphic images are based 
on mathematical expressions. 
They are independent of the 
pixels. For example, when you 

draw a rectangle on a vector layer in 
Krita you are actually drawing paths passing 

through points that are called nodes, which are 
located on specific coordinates on the ‘x’ and ‘y’ axes. 
When you re-size or move these points the computer 
calculates and redraws the path and displays the 
newly formed shape to you. Hence, you can re-size 
the vector shape to any extent without any loss in 
quality. In Krita, everything which is not on a vector 
layer is raster based.
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Vector Layers

This is a layer type on which you draw vector 
graphics. Vector graphics are typically more simple 
than raster graphics and with the benefit that you 
can deform them with less blurriness.

Filter/Adjustment Layers
These layers help us to apply some filters which will 
affect a composite image made from all the layers 
beneath them.

Group Layers

Paint Layers

These are raster layers, and the most common and 
default layer type in Krita, you will be painting on these.

These allow you to group several layers via drag and 
drop, so you can organize, move, apply masks and 
perform other actions on them together.

Types of Layers
Clone Layers

File Layers

Fill Layers

These are copies of the layer you selected when 
making them. They get updated automatically when 
changing the original.

These refer to an existing image outside Krita and 
update as soon as the outside image updates. Useful for 
logos and emblems that change a lot.

These layers are filled with 
something that Krita can 
make up on the fly, like 
colors or patterns.
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Masks are a type of sub-effect applied to a layer, 
usually driven by a grayscale image.

The name mask comes from traditional masking fluid 
and film. You may recall the earlier comparison of 
selections to traditional masking fluid. Selections too 
are stored internally as grayscale images, and you can 
save them as a local selection which is kind of like a 
mask, or convert them to a transparency mask.

The primary types of mask are Transparency Masks, 
which allow you to use a grayscale image to determine 
transparency, where black makes everything 
transparent and white makes the pixel fully opaque.

You can paint on masks with any of the brushes, or 
convert a normal paint-layer to a mask. The big benefit 
of masks is that you can make things transparent 
without removing the underlying pixels. Furthermore, 
you can use masks to reveal or hide a whole group 
layer at once!

Createing a group will also create a mask layer. 

Creating Clipping Masks

Transparency
Transparency refers to the absence of a color in each 
pixel. Transparency is stored in the same way as 
colors, meaning that it’s also a channel. We usually 
call this channel the alpha channel or alpha for short. 
The reason behind this is that the letter ‘α’ is used 
to represent it in programming. When a given pixel 
is completely transparent on all layers, Krita will 
instead show a checkerboard pattern, like the vector 
mask to the left
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More on Filter Layers
We mentioned earlier that you can do math with colors. But you can 
also do math with pixels, or groups of pixels or whole layers. In fact, 
you can make Krita do all sorts of little operations on layers. We call 
these operations Filters.

Filters can be applied destructively to the layer or as a non-destructive 
part of the layer stack. 

Filter Layers affect all the layers underneath it in the same hierarchy. 
Transparency and transparency masks on Filter Layers affect where the 
layer is applied.

Examples of such 
operations are:

Desaturate: This 
makes all the pixels 
turn gray.

Blur: This averages 
the pixels with their 
neighbors, which 
removes sharp 
contrasts and makes 
the whole image 
look blurry.

Sharpen: This 
increases the 
contrast between 
pixels that had a 
pretty high contrast 
to begin with.
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Layer Styles
Layer Effects or Layer Styles are filter masks 
popularized by Photoshop that are a little faster than 
regular masks, but not as versatile. 

They are available by right-clicking a layer and selecting 
‘layer style’. A window of all the layer styles and 
settings will open. 

Merging and 
Flattening Layers
Layers can be merged together into one layer using Ctrl + E.

The top layer will merge with the layer below. 

Vector layers can merge with raster layers, but it will be converted to a raster layer. 

If the layer below is hidden, it will merge as if it is an empty transparent layer. 
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Blend Modes
Because colors are stored as numbers you can do 
math with them. We call this Blending Modes or 
Compositing Modes.

Blending modes can be done per layer, like in the top 
image on the right, or per brush stroke, like the bottom 
image on the right. 

Krita has 76 blending modes, each doing slightly 
different things. Head over to Blending Modes to 
learn more.

Multiply
A commonly used blending mode is for example 
Multiply which multiplies the components, leading 
to darker colors. This allows you to simulate the 
subtractive mixing, and thus makes painting 
shadows much easier.

Addition
Another common one is Addition, which adds one 
layer’s components to the other, making it perfect for 
special glow effects.

Erasing (E)
Erasing is a blending mode in Krita. There is no eraser 
tool, but you can toggle on the brush quickly with the E 
key to become an eraser. You can also use it on layers. 
Unlike the other blending modes, this one only affects 
the alpha channel, making things more transparent.

Normal
The Normal blend mode just averages between colors 
depending on how transparent the topmost color is.

https://docs.krita.org/en/reference_manual/blending_modes.html#blending-modes

Create videos with https://clipchamp.com/en/video-editor - free online video editor, video compressor, video converter.
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Transformations
Transformations are kind of like filters, in that these are 
operations done on the pixels of an image. We have 
a regular image and layer wide transformations in the 
image and layer top menus, so that you may resize, flip 
and rotate the whole image.

We also have the Crop Tool, which only affects the 
canvas size, and the Move Tool which only moves a 
given layer. However, if you want more control, Krita 
offers a Transform Tool.

With this tool you can rotate and resize on the canvas, 
or put it in perspective. Or you can use advanced 
transform tools, like the warp, cage and liquify, which 
allow you to transform by drawing custom points or 
even by pretending it’s a transforming brush.

Deform Brush Engine
Like the filter brush engine, Krita also has a Deform 
Brush Engine, which allows you to transform with 
a brush. This deform is like a much faster version of 
the Liquefy transform tool mode, but in exchange, its 
results are of much lower quality.

Furthermore, you can’t apply the deform brush as a 
non-destructive mask.

Transform Masks
Like filters, transforms can be applied as a non-
destructive operation that is part of the layer stack. 
Unlike filter and transparency masks however, 
Transform Masks can’t be driven by a grayscale image, 
for technical reasons. You can use transform masks to 
deform clone and file layers as well.
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Grids and Guidelines
Because you can hardly 
put a ruler against 
your tablet to help you 
draw, the assistants 
are there to help you 
draw concentric circles, 
perspectives, parallel 
lines and other easily 
forgotten but tricky to 
draw details. Krita allows 
you to snap to these via 
the tool options as well.

Snapping
You can snap to all sorts 
of things. Grids, guides, 
extensions, orthogonals, 
image centers and 
bounding boxes.

Grids and Guides 
Docker
A very straightforward 
guiding tool which shows 
grids or guiding lines that 
can be configured.
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Keyboard Shortcuts

General
Shortcut Action
Ctrl + N New
Ctrl + O Open
Ctrl + S Save
Ctrl + Shift 
+ S

Save As

Ctrl + W Close
Ctrl + Shift 
+ W

Close All

Ctrl + Q Quit
Ctrl + Z Undo
Ctrl + Shift 
+ Z

Redo

Ctrl + X Cut
Ctrl + C Copy
Ctrl + Shift 
+ C

Copy 
Merged

Ctrl + V Paste
Ctrl + Shift 
+ N

Paste into 
New Image

Ctrl + Shift 
+ R

Paste as 
Reference 
Image

Delete Clear
F1 Krita 

Handbook

Painting
B Freehand Brush Tool
Q Multi-Brush Tool
[ Decrease Brush Size
] Increase Brush Size
I Decrease Brush Opacity
O Increase Brush Opacity
Insert key New Paint Layer
F2 Rename Current Layer
Page Down key Activate the Previous Layer
Page Up key Activate the Next Layer
Ctrl + J Duplicate Layer
Ctrl + E Merge Down
Ctrl + Shift + E Flatten All
Ctrl + G Create a New Layer Group
Shift + Delete Remove Layer
Shift + Backspace Fill with Foreground Colour
Backspace Fill with Background Colour
X Switch Foreground and 

Background Color

D Reset Foreground Color to Black 
and Background Color to White

Mouse right-click Show Pop-Up Color Palette
K Darken Color
L Lighten Color
Ctrl + Shift + U Desaturate
C Show Common Color
H Show Color History
Ctrl + B Color Balance
Ctrl + U HSV or HSL Adjust
Ctrl + L Levels
W Wrap-Around Mode
/ Switch to the Previous Preset

Tools
Shortcut Action
B Freehand 

Brush Tool
Q Multi-Brush 

Tool
T Move Tool
C Crop Tool
Ctrl + T Transform 

Tool
G Gradient Tool
E Eraser Mode
P Color Select 

Tool
Ctrl + R Rectangular 

Select Tool
J Elliptical 

Select Tool
F Fill Tool
M Horizontal 

Mirror Tool

Selections
Shortcut Action
Ctrl + A Select All
Ctrl + 
Shift + A

Deselect

Ctrl + 
Shift + D

Reselect

Ctrl + 
Shift + I

Invert 
Selection

Ctrl + H Show/Hide 
Selection

Ctrl + 
Shift + J

Cut Selection 
to New Layer

Navigation and Canvas
Shortcut Action
Tab Show Canvas 

Only
Ctrl + 
Shift + F

Full-Screen 
Mode

Ctrl + + 
/ =

Zoom In

Ctrl + - Zoom Out

1 Zoom 1:1
2 Zoom to Fit

3 Zoom to Fit 
Width

Ctrl + ] 
or 6

Rotate Right

Ctrl + [ 
or 4

Rotate Left

5 Rotate Reset

You can see all keyboard shortcuts, customize 
shortcuts, and create new short cuts by going to 
Settings > Configure Krita > Keyboard Shortcuts
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